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Chapter 1 

AT A GLANCE 

 
 

In this chapter, you will learn: 

• System requirements 

• Software Installation 
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How to Contact Teledyne RD Instruments 
If you have technical issues or questions involving a specific application or deployment with your instru-
ment, contact our Field Service group:  

Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

FAX +1 (858) 842-2822  FAX +33(0) 492-110-931 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com 

Web: http://www.rdinstruments.com 

24 Hour Emergency Support +1 (858) 842-2700 
 

Conventions Used in this Manual 
Conventions used in this documentation have been established to help you learn how to use the system 
quickly and easily. 

Software menu items are printed in bold: File menu, Collect Data. Items that need to be typed by the 
user or keys to press will be shown as F1. If a key combination were joined with a plus sign (ALT+F), you 
would press and hold the first key while you press the second key. Words printed in italics include pro-
gram names (StreamPro) and file names (default.txt). 

Code or sample files are printed using a fixed font. Here is an example: 
StreamPro ADCP 
Teledyne RD Instruments (c) 2012 
All rights reserved. 
Firmware Version: 31.xx  
 
>? 
 
You will find two other visual aids that help you: Notes and Cautions. 

 

This paragraph format indicates additional information that may help you avoid problems or 
that should be considered in using the described features. 

 

 

This paragraph format warns the reader of hazardous procedures (for example, activities that 
may cause loss of data or damage to the StreamPro ADCP). 

 

mailto:rdisales@teledyne.com
mailto:rdie@teledyne.com
mailto:rdifs@teledyne.com
mailto:rdiefs@teledyne.com
mailto:rdicsadmin@teledyne.com
http://www.rdinstruments.com/
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Introduction 
This guide is an overview on using the DVS1 software provided with your system. The DVS program allows 
the user to create a deployment file. After creating a deployment file (or loading an existing file) the DVS 
program will continue with the testing, deployment, and recovery of data. 

 
This guide covers DVS software version 2.04.  

 

 

DVS software version 2.04 supports DVS firmware 55.03 and higher and is not backwards 
compatible. 
• For DVS firmware 41.17 through 55.01 please use DVS software version 2.01. 
• For DVS firmware 41.16 or earlier please use DVS software version 1.05. 

 

System Requirements 
The DVS software requires a Windows® compatible computer with the following specifications: 

• Windows 8®, Windows 7®, Vista®, Windows XP® or Windows 2000®   

 
You must have administrator rights on the computer if you are using Windows 7®/Vista®. 

 

• Pentium III 600 MHz class PC (higher recommended) 

• 64 megabytes of RAM (128 MB RAM recommended) 

• 50 MB Free Disk Space plus space for data files (A large, fast hard disk is recommended) 

• One Serial Port (two or more High Speed UART Serial Port recommended) 

• Minimum display resolution of 1024 x 768, 256 color (higher recommended) 

• CD-ROM Drive 

• Mouse or other pointing device 

Software Installation 
To install the DVS software: 

1. Insert the CDs into the drive.  

2. Use Windows Explorer® to open the CD drive folder.  

3. Double-click on the launch.exe file. When the browser starts click the Install 
button and then click the Install DVS Software button. 

 

Many companies require that Autorun is disabled. Double-click on Launch.exe to start the 
browser on all TRDI software and documentation CDs. 

                                                             
1 DVS is a registered trademark of Teledyne RD Instruments, Inc. 
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NOTES 
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Chapter 2 

USING THE DVS SOFTWARE 

 
 

In this chapter, you will learn: 

• Starting the DVS software  

• Set up DVS RS232 communication  

• Configuring the inductive modems  

• Using the DVS terminal screen  

• Testing the DVS  

• Compass alignment 
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The program DVS is designed to take a user from the planning stage through data recovery. 

Starting the DVS Software 
To start DVS: 

1. In Windows, click Start, Programs, RD Instruments, DVS (default location – use your in-
stallation settings if different). The DVS software will start and display the DVS Wizard 
Startup Options screen. 

 

Figure 1. DVS Startup Options Screen 
 

 

If the Startup Options screen does not display when using Windows 7® or Vista®, right-click on 
the DVS shortcut and select Run as Administrator from the pop-up menu. Select Yes on the 
User Account Control dialog to start the DVS software.  
To always have DVS start with administrator rights, right-click on the DVS shortcut and select 
Properties. On the Compatibility tab, check the Run this program as an administrator box.  

 
2. The DVS Wizard Startup Options screen provides quick access to the most often used func-

tions of the DVS software. You may select one of the functions and click Next or click Cancel to 
begin using DVS.  

• Configure a DVS for a new deployment – This will create a new deployment file and start the de-
ployment wizard (see Deployment Wizard). 

• Test a DVS – this will start the testing portions of the deployment wizard (see Test the DVS). 

• Recover data from a DVS’s recorder – This will open the recover data screen (see Recover Data). 

• Begin a terminal session with a DVS – This will open a terminal window and allow you to “talk” 
to the DVS unit (see DVS Terminal). 
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Set Up DVS RS232 Communication 
The DVS software assumes the last communication protocols configured are correct and opens directly to 
the DVS Wizard Startup Options screen. However, the first time the software is run it is unlikely that 
the default protocols will apply.  

Therefore, on the first start up:  

1. Connect and power up the DVS unit as shown in the DVS Operation Manual. 

2. Start the DVS software. 

3. At the DVS Wizard Startup Options screen, click Cancel.  

4. From the Configure menu, click Serial Communications. 

 

Figure 2. Communication Setting - RS232 Configuration 

5. Select the COM port, baud rate, parity, and stop bits that the DVS unit is connected to. If you are 
unsure of the setting, click the Auto Detect button. 

6. Click Connect. You should see the wakeup message appear on the deployment log window. For 
example; 

> 
DVS 
Teledyne RD Instruments (c) 2010 
All rights reserved. 
Firmware Version: 55.xx   
> 
 

7. Click OK. 

 

Once you establish communications with the DVS unit for the first time, the DVS software uses 
the same settings for future communications.  
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Configuring the Inductive Modems 
This section describes how to setup communications with a DVS unit and how to verify communication 
with the inductive modems.  

System Setup 
The DVS system has an assumed bench top configuration consisting of a surface IMM (a Sea-Bird Induc-
tive Modem) connected to a PC through a serial port and independently powered (i.e. by a 9V battery). 
The surface modem is connected to a powered DVS device via the test cable. See the DVS Operation Man-
ual for the expected bench top setup for the DVS system.  

 

The modem communications have only been tested using Sea-Bird IMM’s with a firmware 
version of 0.99A or higher. The surface IMM used to communicate with the DVS device will 
need to have this firmware version to ensure proper communications. 

 
Both the surface IMM and the IMM built into the DVS system can be configured with the DVS software. 
The surface IMM will need to be configured using this process in order for the software to successfully 
communicate with the DVS device. The DVS IMM is pre-configured upon delivery from Teledyne RD In-
struments. However, this process can be run to ensure that the DVS device has the correct settings or to 
reset it to a valid state if settings are changed accidentally.  

Configuring Serial Connection to Surface IMM 
The first step is to configure the serial connection to the surface IMM.  

1. Connect and power up the DVS unit as shown in the DVS Operation Manual. 

2. Start the DVS software. 

3. At the DVS Wizard Startup Options screen, click Cancel.  

4. From the Configure menu, click Serial Communications. 

5. Select the appropriate COM port (i.e. the port that the surface modem is connected to).  

6. For the baud rate, select 9600. Serial communications with the IMM’s should always be set to 
9600 baud.  

 

The inductive modems actually communicate with each other at a baud rate of 1200, and do 
not support communication with the DVS system at baud rates above 9600. 

 

7. Leave the other settings at their default values as shown in Figure 3.  
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Figure 3. Communication Setting – Inductive Modem Configuration 
 

8. Select the Using an Inductive Modem box and click the Get Modem ID button.  

 

You do not need to check the Using Inductive Modem box to specify the modem 
communication settings. The DVS modem configuration process will fill in these settings for you. 

 
9. Press the OK button to close the Serial Communication Settings dialog.  

10. On the Configure menu, select Modems. This will launch the dialog shown in Figure 4 below. 
Select which modem(s) you wish to configure (i.e. the surface IMM connected to the serial port 
and/or the DVS IMM).  

 

Figure 4. Configure Modems Dialog 

11. If you are configuring the DVS IMM, you have the option of Use Existing Modem ID, or Reset 
Modem ID (from 00 to 99).  

 

The DVS Modem ID that is configured will be applied to the software serial communication 
settings for future modem communications.  
The DVS IMM can only be configured when it is the only device on the line.  
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12. Press the Configure Modems button to start the configuration process. The dialog will update 
with a status bar and information on the configuration steps being run. The configuration process 
will take a few minutes to complete. Once the process in completed, a message box will appear let-
ting you know that the selected configuration(s) are completed (See Figure 5 below).  

 

Figure 5. Configuration Complete Message Box  

If the modem configuration process does not complete successfully, check the serial connection 
from the PC to the surface IMM, and the connection to the DVS system (if you are attempting to 
configure the DVS modem). If the connections look correct and the modem configuration still 
fails, you will need to test your modem connections. The DVS Operation Manual describes how to 
verify modem communications.  
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Using the DVS Terminal Screen 
Use the DVS terminal screen to send any command to the DVS unit. The commands are listed on the left 
hand side of the window. Selecting any of the commands will display a definition of its use on the right-
hand side, with options to choose depending on the command.  

To send a command to the DVS: 

1. Set up communications with the DVS. 

2. On the Tools menu, click Terminal. 

3. Click Send Break to wake up the DVS unit. For every break sent, you should see the wakeup 
message.  

4. Select the name of the command and parameters to be run. Click the Send button.  

 

Figure 6. DVS Terminal Screen 
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Testing the DVS 
To test the DVS: 

1. Connect and power up the DVS unit as shown in the DVS Operation Manual. 

2. Start the DVS program. 

3. At the DVS Wizard Startup Options screen, click Test a DVS. Click Next.  

4. On the Test DVS screen, select Run All Tests (includes the recorder test) or Run Individual 
Tests and select the desired tests. Click the Start Test button. The selected tests will run (see the 
DVS Operation Manual for details on the test printouts). A green check mark next to the test 
name indicates the test passed. If a selected test fails, a red X will be placed next to the test name 
and a dialog box will prompt if you want to continue testing. 

5. The results of the test will be displayed in the Terminal Window area and saved to the log file 
(*.log) if the Log result to file box is selected.  

6. Click OK to exit the Test DVS screen. 

 

Figure 7. Testing the DVS 
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Compass Alignment 
The ISM compass calibration algorithm collects magnetic field vector information for various measured 
headings during the calibration. Hard and soft iron effects rotating with the compass are made observable 
during the calibration by causing the local field to be perturbed as the compass is spun during the calibra-
tion. That is, each component of the hard and soft iron has to alternately increase the local field for some 
orientations and decrease for orientations 180 degrees (or 90 degrees for soft iron) from those orienta-
tions for the algorithm to “notice” it. Tilting and rotating the compass about the vertical axis is sufficient 
to do this. 

 

Figure 8. ISM Compass Calibration 

The TCM5 compass calibration is an automated built-in test that measures how well the compass is cali-
brated. The procedure measures compass parameters over 16 samples. When it has collected data for all 
required directions, the DVS unit computes and displays the results. 

 

Figure 9. TCM5 Compass Calibration 

 

For step-by-step instructions on the compass calibration procedure, see the DVS Operation 
Manual. 
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NOTES 
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Chapter 3 

PLANNING A DEPLOYMENT 

 
 

In this chapter, you will learn: 

• Saving and opening deployment files  

• Using the Deployment Wizard  

• DVS Preparation  

• Deploying the DVS  
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The DVS software uses a wizard to step you through a series of self-explanatory pages to configure the 
desired profiling range and resolution, the number of ensembles per hour, and the time/date to start the 
deployment. Once the planning portion of the wizard is complete, it leads to the Deployment Settings 
page where the final steps can easily be completed to deploy the DVS system. 

Saving Deployment Files 
Save the deployment file by clicking File, Save As. This deployment file will save which steps have been 
completed in the Deployment Wizard.  

Opening Deployment Files 
To open a deployment file, on the File menu, click Open. Select the deployment file to open and click 
Open.  

Using the Deployment Wizard 
The DVS software lets you enter known or “best-guess” values for the various DVS system profiling pa-
rameters and shows predictions of expected results. This lets you play “what if?” with the input parame-
ters to evaluate trade-offs you may have to make with regard to standard deviation, profiling range, and 
timing. 

All new configurations start with the wizard. The wizard guides you through questions about the envi-
ronment, and how you want to setup the DVS unit.  

The DVS software saves the profiling parameters, predicted consequences, and any notes you make in a 
deployment file. The file is intended to configure a DVS unit for a deployment. It is also a record of the 
configuration you chose.  

 

For more information about DVS system commands, see the DVS Operation Manual.  
The DVS software does not send the commands to the DVS until you are ready. Consequently, 
the DVS software can be run at your desk without a DVS unit connected. 

 
After completing the wizard, you can look at the parameters and/or edit them and see the consequences 
change. When you are satisfied, you can save the changes to update the deployment file. As you edit 
settings, the DVS software reviews your changes.  

Error Messages 
If you enter an illegal value, the DVS software displays an error message. For example, if you sent a com-
mand that specified too large a range to a DVS unit, it would reject the illegal command. To prevent this, 
the DVS software displays this error message if you choose a range under 0.03 meters or over 5 meters.  
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Warnings and Cautions 
The DVS software also displays warnings and cautions when a parameter is not advisable or is notewor-
thy. For example, the length of a deployment may be limited by the amount of battery power in the DVS. 
You can enter a longer deployment length, but if you do, the DVS software displays this message. 

 
Some messages may not appear until you reopen a deployment file.  

 

 

You must correct errors before you can continue. You can save a deployment when a warning 
or caution is present. 
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Running the Deployment Wizard 
To run the deployment wizard: 

1. Connect and power up the DVS system as shown in the DVS Operation Manual. 

2. Start the DVS software.  

3. Start the Deployment Wizard by doing one of the following: 

• At the DVS Wizard Startup Options screen, click Configure an DVS for a New De-
ployment.  

• Click File, New Deployment (  on the tool bar).  

• If you are working with a deployment file (*.dvs), on the File menu, click Open. 

4. The first step is planning. If you want to skip this step, check the Skip Planning Step box (see 
Figure 10), or click Next to continue. 

 

Figure 10. DVS Wizard - Deployment Planning 
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5. Select the depth range (1 to 5 meters) you wish to measure (see Figure 11).  

6. Set the resolution (depth cell size) to between 0.03 to 5.0 meters. A larger depth cell (bin) size de-
creases the standard deviation, but shallow water situations may need to use small depth cells 
(bins) to get more data points.  

7. Set the range to the 1st cell (blank) to between 0.03 (default) to 5 meters. 

8. The DVS software will automatically set the number of depth cells (bins) and show the first and 
last cell range. Click Next. 

 

Figure 11. DVS Wizard – Water Profile 



September 2015 Doppler Volume Sampler (DVS) Software User’s Guide 

Page 20 EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page.  
 

9. Select how many ensembles per hour you want to record (Figure 12). The DVS software will au-
tomatically set the time between ensembles. Click Next.  

 

Figure 12. DVS Wizard – Measurement Frequency 
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10. Enter the expected duration of the DVS deployment from the time of the first water profiling ping 
(either immediately or first ping date/time, see Figure 13). This duration does not produce a 
command to instruct the DVS to stop data collection; it is for estimating consequences only. This 
duration is used to estimate the following consequences: Battery Power usage, and Storage re-
quired. Click Next to continue. 

 

Figure 13. DVS Wizard – Deployment Date/Duration 

11. The DVS Deployment Settings screen opens using the settings you selected with the wizard.  

 

Figure 14. DVS Wizard – Deployment Settings 
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Deployment Timing Setup 

• Start Date/Time - Ping Immediately After Deployment –  
Select whether to start the deployment immediately or delayed. Un-checking the box and en-
tering a Start Date and Start Time in this field enables a delay from the start of a deploy-
ment to the first water profiling ping. When enabled, the DVS system will begin collecting ve-
locity data at the date and time specified by the first ping date and time. The DVS will sleep 
from the time the commands are sent to the DVS until the first ping date and time. Make sure 
that the time is in the future and that the DVS clock is properly set. 

• Duration – Enter the expected duration of the DVS deployment. This duration does not 
produce a command to instruct the DVS to stop data collection; it is for estimating conse-
quences only.  

Environmental Setup 

• Depth Rating – Select if the DVS is rated to 750 meters (Standard) or 6000 meters. 

• Salinity – Fresh water is 0 and salt water is typically 35. Salinity is used to calculate the 
speed of sound. The speed of sound is used by the DVS unit to scale the velocity data properly.  

 

If you use 0 for salinity when you deployed in water with salinity of 35, then your data will have 
a 3% velocity estimate error. 

 

• Transducer Depth – The DVS uses depth in its speed of sound calculations. If the pressure 
sensor is not available, then the DVS will use this manual depth setting. 

• Magnetic Variation – The DVS uses a flux-gate compass that measures magnetic north. 
You must set the magnetic offset in order to obtain true north referenced velocity data direc-
tions.  

Profiling Setup 

• Ensemble Interval – This sets the (minimum) interval over which the DVS will collect and 
average the pings per ensemble and record data. The format of this field is hh:mm:ss, where 
hh = hours, mm = minutes, and ss = seconds.  

• Pings Per Ensemble – Adjust the number of pings to get the desired Standard Deviation. 
To increase the expected accuracy of the velocity measurement (reduce the Standard Devia-
tion), you can increase either pings per ensemble, bin size or both. 

• Number of Depth Cells – Sets how many depth cells (bins) are used. The Last Cell 
Range field provides the last range that you have setup the system to collect. To increase the 
Last Cell Range, enter more depth cells or increase the depth cell size. A maximum of five 
depth cells can be used. 

• Depth Cell Size – Set the depth cell (bin) size. 

• Ping Interval – Selecting the Auto box will evenly space the pings throughout the 
ensemble, up to the maximum ping interval. If a quick burst of pings is preferred, then the 
time between pings can be programmed directly by un-checking the Auto check box.  

• Blank Distance – Moves the location of the first depth cell away from the transducer head. 

Sensor Setup 

To automatically detect what sensors are installed on the DVS, click the Detect Sensors button.  

• If the DVS Has a CTD, select Yes, otherwise select No. 

• Under the CTD Feature, select Don’t Use or SBE37SMP (data from the CTD will be saved 
to the PD20 Output Data Format). 

• Select Yes if the DVS includes a Pressure Sensor, otherwise select No. 
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• Under Pressure Sensor, select Don’t Use or Use (data from the pressure sensor will be 
saved to the PD20 Output Data Format). 

• Select the type Thermometer the DVS is using. Choose between the TRDI standard ther-
mistor, Integrated Sensor Module (ISM), and the Sea-Bird SBE38 thermistor. 

Inductive Modem Setup 

• The Inductive Modem Setup allows evaluation of modem communications on power con-
sumption; it does not configure the actual communications. Enter a Data Transfers per 
Day value to see the Power Usage and Battery Used consequences. All Inductive Modem 
communications are initiated from the surface modem, not the DVS. 

12. Review the following consequences.  

• First Cell Range – The range from the transducer face to the middle of the first depth cell (bin). 
The depth cell (bin) size and the WF (blank) command in the command file primarily affect 
where it is located. 

• Last Cell Range – The last depth cell range is determined from the number of depth cells (bins), 
depth cell size, and first depth cell range. 

• Max Range – The maximum profiling range is dependent on the DVS frequency, water salinity, 
water temperature, and the depth of the DVS. A warning message will appear if the maximum 
range exceeds 6 meters (see Warnings and Cautions).  

 

Figure 15. DVS Deployment Consequences 
 

• Bin Standard Deviation – Shows the expected standard deviation of the velocity data stored in 
each bin of the ensemble being collected by the DVS. Most users will want to minimize this 
value so that they obtain the best data possible (i.e. data containing the least amount of 
noise). Standard deviation is dependent on depth cell (bin) size, the number of pings in an 
ensemble, the water mode, and the ambiguity velocity.  

Blank (0.3 to 5m)

Bin 1

Bin 2

Bin 3

Bin 4
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• Ensemble Size – Shows the size in bytes of the each ensemble that is either transmitted or rec-
orded by the DVS.  

• Storage Required – Shows the amount of storage space required in megabytes (MB) to record 
the data generated by the DVS over the duration of the deployment. This value should be 
compared to the free space available on the internal DVS PC card recorder and/or free space 
on the Computer logging the data transmitted to the serial interface. Free space on the DVS 
internal recorder can be determined by using the MM command (see Check the Recorder Sta-
tus). To convert MB to bytes, multiply the number by 1,048,576 (1024*1024).  

• Power Usage – The Power Usage will reflect how many watt-hours are required.  

• Battery Used – The Battery Used will reflect what percentage of the battery is used.  

13. Select the Show Commands box to view the commands generated by DVS. The commands 
shown in Table 1 explain each command set or added by DVS. These commands directly affect the 
range of the DVS, standard deviation (accuracy) of the data, and battery usage. Table 1 explains 
the commands used in the sample deployment file for a DVS.  

Table 1: Command File Created Using DVS 
Command Choices Description 

CR1 Sets factory defaults This is the first command sent to the DVS to place it in a “known” state. 

CF11100 Flow control Record binary data internally on the PC card recorder. 

TF060712080000 Time of first ping DVS will begin pinging on July 12, 2006 at 8:00 am. 

ES35 Salinity Salinity of water is set to 35 (saltwater). 

ED0 Transducer depth Manually set depth of the transducer. If a pressure sensor is installed, the ED-command will 
be used only if the depth sensor fails. 

EB0 Heading bias Magnetic variation. 

TE00100000 Time per ensemble Ensemble interval is set to 10 minutes. 

WP1 Number of pings Number of pings is set to 1 

WN5 Number of depth cells Number of depth cells (bins) is set to 5. 

WS50 Depth cell size Depth cell (bin) size is set to 0.50 meters. 

TP100000 Time between pings The DVS software automatically sets the time between pings to spread the pings evenly 
throughout the ensemble. 

WF030 Blank after transmit Moves the location of the first depth cell more than 0.3 meters away from the 
transducer head. The First Cell Rage is displayed under Deployment Conse-
quences.  

CK Keep parameters as 
user defaults 

If power is lost and then restored, all commands will be restored as last sent. 
Sent right before the CS-command. 

CS Start pinging Last command sent to begin collecting data. 
 

14. Move the cursor to the Notes section. Use the area to include notes about the deployment. 

15. Any step beyond this point requires communication with a DVS system. If a DVS is not available, 
you can save this configuration for later use by un-checking the Continue to deployment check 
box and clicking Next. Otherwise, you will be prompted to save the deployment file generated 
here, and will proceed to configuring the DVS for deployment (see DVS Deployments and Figure 
17. 

16. Name the deployment file and click Save to save the deployment file (see Saving Deployment 
Files). The DVS software will automatically add the extension *.dvs to the file.  
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DVS Preparation 
Proper DVS preparation is critical for a successful deployment. Use this list to ensure the DVS is prepared 
for deployment.  

 

DVS preparation can take place up to one month before the deployment in a land-based 
laboratory. It can be configured for deployment at this time, with a programmed wake-up time 
for the anticipated time of deployment. 

 

Deployment Checklist 

 Visual Inspection and Cleaning 
 Check the housing condition for damage 
 Check the transducer faces are clean and free from defects 
 Clean the optional temperature sensor guard 
 Apply antifouling paint as needed 

 Seal the DVS for deployment 
 Install and connect a fresh battery  
 Use fresh desiccant (1 bag) inside DVS 
 Install new O-rings; use silicone lubricant 
 Check all mounting hardware is installed 

 Bench Test 
 Test the DVS unit using the DVS software 
 Align the compass using the DVS software 

 Final Preparation for Deployment 
 Plan the Deployment using the DVS software 
 Set Clock Data and Time using the DVS software 
 Erase the recorder using the DVS software 
 Send deployment commands using the DVS software 
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Deploying the DVS 
To deploy the DVS: 

1. Connect the DVS unit to a computer running the DVS software via either the RS232 communica-
tions or the inductive modem.  

2. A command file must be loaded into the DVS software, either having been generated in the plan-
ning module (see Using the Deployment Wizard), or loaded directly from the File, Open menu. 
In either case, the DVS software display should be at the Deployment Settings screen as shown 
in Figure 14.  

3. Check the Continue to deployment checkbox and click Next to reach the DVS Deployment 
screen shown in Figure 16. 

 

Figure 16. DVS Deployment Screen 

This screen contains the most commonly used “last minute” items done just prior to physically deploying 
the DVS unit. These include: Set DVS Clock (usually to the time on the connected PC); Erase DVS Re-
corder (not selected by default to avoid inadvertent loss of data); selecting the diagnostic tests to be run, 
Zero Pressure Sensor (will be checked if the DVS has a pressure sensor), and Deploy DVS (which 
uploads the selected command file to the DVS unit).  

4. Select the Log results to file: check box and select a file name using the Browse button. This 
will save the communications to the DVS to a text file. 

5. Once all of the desired options are checked, click the Next button.  
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Figure 17. DVS Wizard – Deployment 

6. A Results box will open and display the communications to the DVS in real time as the steps are 
run. A green check mark next to each step indicates there were no problems; a red X indicates a 
problem or that the step was skipped. 

Once the commands have been sent to the DVS: 

• Disconnect the test I/O cable and use the DVS Operation Manual to verify the DVS unit is 
sealed and ready for deployment.  

• Deploy the DVS. 
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Chapter 4 

USING THE DVS RECORDER FUNCTIONS 

 
 

In this chapter, you will learn: 

• Recovering the entire data set  

• Getting data during the deployment 

• Converting data 

• Checking and erasing the recorder 



Doppler Volume Sampler (DVS) Software User’s Guide September 2015 

 EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page. Page 29 
 

The DVS software has the capability to recover and convert data, check the status, and erase the recorder. 

Recovering the Entire Data Set 
Once you have recovered the DVS, you should refer to the Maintenance section of the Operation Manual 
for instructions on cleaning the DVS unit exterior. Use the DVS software to recover the data once the DVS 
is clean and dry. The DVS software reads the data from the DVS’s internal recorder and transfers the data 
to the computer’s hard disk. Select a directory name on the computer’s hard drive where the data will be 
written.  

 

It is highly recommended to use the I/O cable and increase the baud rate to 115200 BAUD to 
reduce the download time. Use external power to save battery power. 

 
1. Connect and power up the DVS unit as shown in the DVS Operation Manual.  

2. Start the DVS software.  

3. At the DVS Wizard Startup Options screen select Recover Data from an DVS’s Record-
er or from the Tools menu, select Recover Recorder Data.  

4. Browse to an appropriate directory for the download.  

5. Select what Download Entire Data Set.  

6. Select the data format. The raw data format is a compressed file format created to minimize the 
memory requirements for the DVS unit and better accommodate long deployments. The raw data 
stored can be converted to TRDI standard PD0 format on extraction, which can then be read by 
TRDI standard software tools such as WinADCP (see Convert Data). 

7. Click the Download… button to begin downloading data. 

 

Figure 18. Recover Data Screen 
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Getting Data during the Deployment 
The DVS unit allows communication with the outside world without interrupting the data acquisition 
schedule. There are three special ways to collect data from a DVS that is deployed and gathering data au-
tonomously. These three are: 

• Download Average of All Data Since Last Request – This command returns the aver-
age of all ensembles collected since the last time the command was sent. 

• Download Last Ensemble – This commands the DVS to return the most recently recorded 
ensemble. 

• Collect and Download a New Ensemble – This commands the DVS to gather an addi-
tional ensemble right now and send it back (this ensemble is not recorded - so if it gets lost, 
it’s gone). If an ensemble is requested will interfere with a preprogrammed ensemble (within 
two seconds), then the DVS will send an error message. 

 

When using these commands via the inductive modem, it is important to follow with a CZ 
command after successful execution of this command. The CZ command will force the DVS to 
sleep immediately; otherwise, the IMM will keep the DVS awake for its time-out window of 2 to 
3 minutes, which will drain the battery much sooner than the planning software would indicate. 

 

 

If the ensemble time is less than 30 seconds, - Download Last Ensemble and Collect and 
Download a New Full Ensemble may not work. 
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Collecting Average 
To collect an average of all ensembles collected since the last time the command was sent:  

1. Start the DVS software.  

2. At the DVS Wizard Startup Options screen select Recover Data from a DVS Recorder. 

3. Browse to an appropriate directory for the download.  

4. On the Data to Download section, select Download Average of all Data Since Last Re-
quest. 

5. Select the Raw (Compressed) data format.  

6. Click the Download… button to begin downloading data. 

 
 



September 2015 Doppler Volume Sampler (DVS) Software User’s Guide 

Page 32 EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page.  
 

Collecting Last Ensemble 
To return the most recently recorded ensemble:  

1. Start the DVS software.  

2. At the DVS Wizard Startup Options screen select Recover Data from a DVS Recorder. 

3. Browse to an appropriate directory for the download.  

4. On the Data to Download section, select Download Last Ensemble.  

5. Select the Raw (Compressed) data format.  

6. Click the Download… button to begin downloading data. 

 
If the ensemble time is less than 30 seconds, - Download Last Ensemble may not work. 

 

 

Collecting One New Ensemble 
To collect a new ensemble:  

1. Start the DVS software.  

2. At the DVS Wizard Startup Options screen select Recover Data from a DVS Recorder. 

3. Browse to an appropriate directory for the download.  

4. On the Data to Download section, select Collect and Download a New Ensemble.  

5. Select the Raw (Compressed) data format.  

6. Click the Download… button to begin downloading data. 
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If the ensemble time is less than 30 seconds, - Collect and Download a New Full Ensemble may 
not work. 

 

 
 

 

Converting Data 

Convert PD20 to PD0 
The PD20 raw data format is a compressed file format that is not readable by WinADCP. To convert the 
PD20 data to TRDI standard PD0 format, do the following. 

1. Recover the raw PD20 (compressed data) from the DVS recorder (see Recover Data). 

2. On the Tools menu, select Convert PD20 to PD0.  

3. Use the Browse button to locate the PD20 file to convert. 

4. Click Browse to select a folder and file name for the PD0 file. Click Save. 

5. Click the Convert File button to begin the conversion. 

6. Click OK on the File Converted message box. 



September 2015 Doppler Volume Sampler (DVS) Software User’s Guide 

Page 34 EAR-Controlled Technology Subject to Restrictions Contained on the Cover Page.  
 

 

Figure 19. Convert PD20 File to PD0 

Convert PD20 to ASCII 
To convert the PD20 data to ASCII format: 

1. Recover the raw PD20 (compressed data) from the DVS recorder (see Recover Entire Data Set 
from DVS). 

2. On the Tools menu, select Export PD20…   

3. Use the Browse button to locate the PD20 file to convert. 

4. Click Browse to select a folder and file name for the ASCII file. Click Save. 

5. Click the Export File button to begin the conversion. 

6. Click OK on the File Converted message box. 

 

Figure 20. Convert PD20 File to ASCII 

Example ASCII file 
Ensemble #,Year,Month,Day,Hour,Minute,Second,Time Between Pings (seconds),# of Pings,BIT,Sensor 
Source,Battery Voltage (volts),Average Heading (degrees),Average Pitch (degrees),Average Roll 
(degrees),Average Omega,Average Temp (degrees C),Average Pressure,Std Dev Heading (degrees),Std 
Dev Pitch (degrees),Std Dev Roll (degrees),Std Dev Omega,Std Dev Temp (degrees C),Std Dev Pres-
sure,Coordinate System,Bin Size (cm),Bin 1 Distance(cm;>0=up;<0=down),# of Ensembles,# Bins,Bin 0 
Velocity 1 (m/s),Bin 0 Velocity 2 (m/s),Bin 0 Velocity 3 (m/s),Bin 0 Velocity 4 (m/s),Bin 0 Am-
plitude 1,Bin 0 Amplitude 2,Bin 0 Amplitude 3,Bin 0 Amplitude 4,Bin 0 Correlation 1,Bin 0 Corre-
lation 2,Bin 0 Correlation 3,Bin 0 Correlation 4,Bin 0 % Good 1,Bin 0 % Good 2,Bin 0 % Good 3,Bin 
0 % Good 4,Bin 1 Velocity 1 (m/s),Bin 1 Velocity 2 (m/s),Bin 1 Velocity 3 (m/s),Bin 1 Velocity 4 
(m/s),Bin 1 Amplitude 1,Bin 1 Amplitude 2,Bin 1 Amplitude 3,Bin 1 Amplitude 4,Bin 1 Correlation 
1,Bin 1 Correlation 2,Bin 1 Correlation 3,Bin 1 Correlation 4,Bin 1 % Good 1,Bin 1 % Good 2,Bin 1 
% Good 3,Bin 1 % Good 4,Bin 2 Velocity 1 (m/s),Bin 2 Velocity 2 (m/s),Bin 2 Velocity 3 (m/s),Bin 
2 Velocity 4 (m/s),Bin 2 Amplitude 1,Bin 2 Amplitude 2,Bin 2 Amplitude 3,Bin 2 Amplitude 4,Bin 2 
Correlation 1,Bin 2 Correlation 2,Bin 2 Correlation 3,Bin 2 Correlation 4,Bin 2 % Good 1,Bin 2 % 
Good 2,Bin 2 % Good 3,Bin 2 % Good 4,Bin 3 Velocity 1 (m/s),Bin 3 Velocity 2 (m/s),Bin 3 Velocity 
3 (m/s),Bin 3 Velocity 4 (m/s),Bin 3 Amplitude 1,Bin 3 Amplitude 2,Bin 3 Amplitude 3,Bin 3 Ampli-
tude 4,Bin 3 Correlation 1,Bin 3 Correlation 2,Bin 3 Correlation 3,Bin 3 Correlation 4,Bin 3 % 
Good 1,Bin 3 % Good 2,Bin 3 % Good 3,Bin 3 % Good 4,Bin 4 Velocity 1 (m/s),Bin 4 Velocity 2 
(m/s),Bin 4 Velocity 3 (m/s),Bin 4 Velocity 4 (m/s),Bin 4 Amplitude 1,Bin 4 Amplitude 2,Bin 4 
Amplitude 3,Bin 4 Amplitude 4,Bin 4 Correlation 1,Bin 4 Correlation 2,Bin 4 Correlation 3,Bin 4 
Correlation 4,Bin 4 % Good 1,Bin 4 % Good 2,Bin 4 % Good 3,Bin 4 % Good 4 
0,2009,10,20,06,50,11,360,77,0,0x1022201,3.0,0.84,51.58,586.99,32768,23.192,2147483648,0.11,0.05,
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0.10,32768,0.005,2147483648,0x1f,50,-55,6,5,-32768,-32768,-32768,-
32768,84,85,71,82,32,26,28,29,0,0,100,0,-32768,-32768,-32768,-
32768,65,67,49,62,7,7,6,6,0,0,100,0,-32768,-32768,-32768,-32768,65,67,49,62,9,6,6,6,0,0,100,0,-
32768,-32768,-32768,-32768,65,67,49,62,8,7,7,7,0,0,100,0,-32768,-32768,-32768,-
32768,65,67,49,61,8,6,7,6,0,0,100,0 

Checking the Recorder Status 
To see how much memory is used on the recorder:   

1. Connect and power up the DVS unit as shown in the DVS Operation Manual. 

2. Start the DVS software.  

3. On the Tools menu, click Recorder Status. This will open Recorder Status screen (see Fig-
ure 21).  

4. Click the Get Status button.  

5. The results of the test will be displayed in the Recorder Status area and saved to the log file 
(*.log) if the Log result to file box is selected.  

6. Click OK to exit the Recorder Status screen. 

 

Figure 21. Recorder Status 
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Erasing the Recorder 
Once all data has been recovered, the recorder can be erased. Once erased, the data is not recoverable. 

To erase the recorder:  

1. Connect and power up the DVS unit as shown in the DVS Operation Manual.  

2. Start the DVS software.  

3. Recover the data (see Recover Data). Once erased, the data is not recoverable. 

4. On the Tools menu, click Erase Recorder Data. 

5. Type ErAsE (you must use the exact upper and lower case characters). 

6. Click OK. 

 

Figure 22. Erase the Recorder 

 
Data is not recoverable after erasing. 
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Appendix A 

DVS SOFTWARE HISTORY 

 
 

In this chapter, you will learn: 

• DVS software history 
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Version 2.04  

• Added compatibility for TCM5 compass calibration. 

Version 2.03 

• Power model updated to support Pressure Sensor, Seabird Temperature Sensor, and the 
TRDI Temperature Sensor 

• When the system creates the PD0 file it now writes the correct firmware version (55.01) into 
the file. 

• DVS software now recognizes the TRDI Temperature Sensor. 

• Pressure data is now included when converting from PD20 to PD0. 

• Update DVS ISM calibration to latest code. 

• Add Depth to .TXT output. 

• Depth and Pressure changed in PD0 Variable Leader to match FW change. 

• Terminal Window EZ command updated to include enabling/disabling the Depth/Pressure 
sensor. 

Version 2.02 

• Internal release 

Version 2.01 

• Power model updated. 

• Fixed problem with the calendar control on Windows 7. 

Version 2.00 

• Software now supports DVS Firmware 55.xx and higher. DVS firmware versions 55.xx are 
NOT backwards compatible with DVS 41.xx firmware. For DVS Firmware 41.16 or earlier 
please use DVS Software v1.04. 

• Added support for the new ISM compass. 

• Added option to export PD20 as ASCII. 

• Corrected Max Range warning and added to water profile page. 

• Added validation for ensemble time with number of samples. 

• Updated Copyright to 2009. 

Version 1.04 

• Updated a warning about DVS not sleeping if TP<= 3.0s  

• Made it easier to enter custom sample intervals such as 00:02.00  

• Added ‘approx’ to the calculation of pings per ensemble  
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Version 1.03 (internal TRDI release only) 

• Fixed problem with installation on foreign machines. 

• Added ability to set IMM communication time used in the power consumption calculation. 

• Added display for calculated ‘Pings per Sample’. 

• Changed warning font. 

• Added ability to send PC2 and PC4 commands over IMM. 

• Fixed problem with allowing disabled IMM commands when in lower case. 

• Added depth rating setting to DVS setup. 

Version 1.02 

• Fixed problem with TF format generated in the wizard  

Version 1.01 - Initial Release. 
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